
 

3D Modeling & Printing Information 

Websites 

Creality Website - https://www.creality.com/ 
 
Creality Print - https://www.crealitycloud.com/downloads/software/creality-print  
 
Creality Ender-3 V3 – Best Cura Settings & Profile - https://the3dprinterbee.com/creality-ender-3-v3-
cura-settings-profile/  
  
Cults 3D Models - https://cults3d.com/en 
 
Thingiverse 3D Models - https://www.thingiverse.com/ 
 
Printables 3D Models - 3D models database | Printables.com  
 
MakerWorld 3D Models - https://makerworld.com/en  
 
Thangs 3D Models - https://thangs.com/  
 
Yeggi 3D Models - https://www.yeggi.com/  
 
Autodesk Fusion 360 - https://www.autodesk.com/products/fusion-360/personal?  
 
Good Video on using Variable Layer Heights in Creality Print - 
https://www.youtube.com/watch?v=jtbcYLDfg14&t=53s  
 
  



These are the most important slicer settings for the Ender-3 V3: 
Quality: 
Layer Height: 0.2 mm 
Line Width: 0.4 mm 
The layer height should be between 25% and 75% of the nozzle diameter. For a 0.4 mm nozzle, this means 
between 0.1 and 0.3 mm. 
The line width should be between 100% and 120% of the nozzle diameter. For a 0.4 mm nozzle, this means 
between 0.4 and 0.48 mm. 
 
Walls: 
Wall Line Count: 2-4 
Wall Ordering: Inner/Outer/Inner 
The wall thickness mainly depends on how stable the object has to be. More walls = more stability. 
 
Top/Bottom: 
Top Layers: 4-8 
Bottom Layers: 4-8 
Monotonic Top/Bottom Order: Yes 
The same applies here: more top/bottom layers = more stability. 
 
Infill: 
Decorative objects: 0-15% 
Standard objects: 15-50% 
Stable objects: 50-100% 
If you print thin walls, it can sometimes happen that the infill shows through from the inside. In this case, 
you should decrease the “Infill Overlap Percentage” settings. 
 
Material: 
Printing Temperature: 
PLA: 215 °C 
ABS: 260 °C 
PETG: 250 °C 
TPU: 225 °C 
Build Plate Temperature: 
PLA: 60 °C 
ABS: 100 °C 
PETG: 70 °C 
TPU: 50 °C 
The print temperature is one of the settings that should definitely be calibrated. 
You can’t go too far wrong with the temperature of the build plate, as the print bed of the Ender-3 V3 
offers excellent adhesion for most filaments. 
 
Speed: 
Print Speed: 250 mm/s 
Initial Layer Speed: 20 mm/s 
The considerably reduced speed of the first layer helps to increase the print bed adhesion. 



 
Travel: 
Retraction Distance: 
PLA: 0.7 mm 
ABS: 0.7 mm 
PETG: 0.8 mm 
TPU: 0.8 mm 
Retraction Speed: 
PLA: 40 mm/s 
ABS: 40 mm/s 
PETG: 45 mm/s 
TPU: 45 mm/s 
Z-Hop When Retracted: Yes 
Z-Hop Only Over Printed Parts: Yes 
Z-Hop Height: 0.6 mm 
Retraction is also one of the settings that must be calibrated. Otherwise, stringing will quickly occur. 
 
Cooling: 
Fan Speed: 
PLA: 100% 
ABS: 50% 
PETG: 100% 
TPU: 100% 
Minimum Layer Time: 8 s 
Cooling only needs to be reduced for ABS. ABS has a strong tendency to warp as it shrinks during cooling. 
As the Ender-3 V3 does not have a closed print volume, it can only process ABS to a limited extent. 
However, smaller objects are certainly possible. 
If you cannot avoid drafts, a draft shield could be an option. 
 
Build Plate Adhesion: 
Build Plate Adhesion Type: Skirt 
As already mentioned, the print bed adhesion of the Ender-3 V3 is excellent. It is therefore only 
necessary to print a Brim or Raft in very few cases. 
 
Here is a table of the 4 most common Ender 3 filaments to see all settings at a glance: 

PLA  ABS   PETG   TPU 
Extruder Temperature 180 – 230 °C 220 – 240 °C  230 – 250 °C  220 – 240 °C 
Printing Bed Temperature 40 – 60 °C 80 – 100 °C  70 – 90 °C  40 – 60 °C 
Print Speed    max. 60 mm/s max. 60 mm/s  max. 60 mm/s  max. 30 mm/s 
Retraction Distance  5 mm  5 mm   5 – 7 mm  as small as possible 
Retraction Speed  45 mm/s 45 mm/s  min. 40 mm/s  max. 30 mm/s 
Cooling    Yes  No   Yes   Yes 
 
 
 
 



Creality Ender-3 V3 
Best Slicer Settings for Ultra-Fine Detail Printing using 0.2mm Nozzle 
These parameters form the core of your ultra-fine detail configuration. 
 
Layer Height  Best Setting: 0.05 - 0.1 mm 
Why It Matters: 
A 0.2mm nozzle excels at ultra-thin layers. Printing at 25 – 50% of the nozzle diameter ensures strong 
layer bonding and high resolution. Avoid using a layer height higher than 0.12 mm. 
Typical Use: 
0.05 mm for extremely fine surface detail (miniatures, figurines) 
0.08 – 0.1 mm for detailed mechanical models 
 
Line Width  Best Setting: 0.2 - 0.24 mm 
Why It Matters: 
Setting line width too narrow causes under-extrusion; too wide causes flow inconsistencies. Most slicers 
automatically set line width equal to the nozzle diameter, but you can adjust it slightly for better surface 
control. 
Recommendation: 
Start with a line width of 0.22 mm for perimeter and wall printing. 
 
Print Speed   Best Setting: 10 – 30 mm/s 
Why It Matters: 
Fine nozzles cannot push filament as fast as standard nozzles. Printing too quickly causes gaps, missed 
steps, or uneven extrusion. Slower speeds provide better detail and prevent vibrations from affecting 
accuracy. 
Suggested Speeds: 
Walls/perimeters: 15 – 25 mm/s 
Infill: 25 – 30 mm/s 
Small details and features: 10 – 15 mm/s 
 
Retraction Settings 
Recommended Settings: Distance: 1 – 2 mm for direct drive; Speed: 20 – 40 mm/s 
Why It Matters: 
Because 0.2mm nozzles are narrow, they are more prone to stringing and clogs. Precise retraction helps 
reduce oozing, but overly aggressive retraction can cause jams or delay re-priming. 
Test retraction carefully with small models before larger prints. 
 
Cooling Fan Speed  Recommended Setting: PLA: 80 – 100%; PETG: 50 – 60% 
Why It Matters: 
Fine nozzles lay down less filament per second, so cooling becomes more important to solidify small 
features. Too much cooling can cause warping on high-temp filaments, while too little cooling causes 
stringing and sagging. 
 
Extrusion Multiplier / Flow Rate Best Setting: 95 – 100% (start with 100%) 
Why It Matters: 



Under- or over-extrusion affects layer adhesion and print quality more noticeably with fine nozzles. 
Perform flow calibration tests using a single-wall cube to fine-tune this value. 
 
First Layer Settings 
Recommended Settings: First layer height: 0.15 – 0.2 mm; First layer speed: 10 – 15 mm/s 
Z-offset calibration: Crucial due to narrow gap 
Why It Matters: 
The first layer must be accurate and uniform. With a 0.2mm nozzle, improper bed leveling causes nozzle 
drag, uneven extrusion, or poor adhesion. 
Calibrate the Z-offset carefully and use a clean, level bed surface. 
 
Advanced Tips for Ultra-Fine Detail Printing 
Use Adaptive Layer Height: Reduces print time by using finer layers in detailed areas and thicker layers 
elsewhere. 
 
Print at Cooler Temperatures for PLA: Helps reduce stringing and drooping on small features. 
Enable “Outer Walls First” in Slicer: Improves surface accuracy by printing visible areas before internal 
ones. 
 
Reduce Acceleration and Jerk Settings: Lowers vibrations and enhances fine feature consistency. 
Use Smaller Text Sizes Effectively: A 0.2mm nozzle can cleanly render text as small as 3–4 mm in height 
when properly tuned. 
  



Creality Print 6.2 Settings for Ender-3 V3 with Hyper-PLA using 0.2mm Nozzle 
 

 
 



 
 



 
 



   



   



   



   



   
  



Ender-3 V3 Nozzle Replacement Step-by-Step 
Select “Movement/Temp” - “Z-axis origin”, wait for the machine homing; Select "30mm" - "Z-axis up", and 
raise the Z-axis to middle position (120mm). 
 
Select “Extrude/Retract” – “Retract”, wait for the machine to heat up to 220 °C, complete the filament 
unloading; “Open” the filament clamp and remove the Teflon tube and filament. 
 
Select “Movement/Temp” – “Temp”, set temperature to “0”; Select “Cooling” – turn on the “Auxiliary 
Cooling” - “Model Cooling”, and adjust both to “100%”, wait for the temperature to drop to room 
temperature. 
 
Remove the two 5/64” hex head screws from the fan cover (one on each side), disassemble the fan cover, 
and unplug fan motor from printer head circuit board; now remove the silicone sleeve from around the 
nozzle at the bottom of extruder. 
 
On control panel “Home” screen set nozzle temperature to 220 °C and press “OK”, wait for the 
temperature to rise to the set value. 
 
Loosen the nozzle throat 5/64” hex head set screw on right side of extruder head; using the nozzle socket 
wrench turn counterclockwise to remove the old nozzle (caution, the nozzle will be very hot). 
 
Apply thermal grease to nozzle smooth center copper sleeve, spread the thermal grease evenly; insert the 
new nozzle into the bottom of the extruder and using the nozzle socket wrench turn clockwise to install 
the new nozzle (do not overtighten) now tighten the nozzle throat hex head set screw. 
 
On control panel “Home” screen set nozzle temperature to  0 °C and press “OK”; Select “Cooling” – turn on 
the “Auxiliary Cooling”, and adjust to “100%”, wait for the temperature to drop to room temperature. 
 
Install silicone sleeve back over printer nozzle on bottom of extruder head; plug fan motor back into 
printer head circuit board and reinstall the fan cover using the two hex head screws removed earlier. 
 
Reload the filament and “Close” the filament clamp; Select “Extrude/Retract” – “Extrude”, wait for the 
machine to heat up to 220 °C, observe whether the nozzle discharges smoothly. 
 
Perform a self-test of the printer; Select “System Icon” – “Self-Check” – “Select Input Shaping and Auto 
Leveling” – “Start Detecting”; and wait for machine self-test to complete. 
 
 
 
  



Printing with PLA 
PLA, the “polylactic acid”, is the most widely used printing filament of all. That is why it’s processing on 
the Ender 3 is particularly problem-free. In fact, the 3D printer is optimized to use PLA. 
 
When printing PLA it is important that the printer is not enclosed. Even if you like it “neat” and 
have built a nice housing for your printer, this can cause problems when printing PLA. 
 
The print data for PLA are as follows: 
Extruder temperature: 190 – 220 °C 
Print speed: 60 mm/s (recommended value) 
Retraction distance: 5 mm 
Retraction Speed: 45 mm/s 
Cooling: required 
These basic technical characteristics are fulfilled by the Ender 3. Its temperature at the tip of the nozzle 
is exactly in the range required for the production of extruded PLA.  
 
PLA has the pleasant property of not necessarily requiring a heated printing bed. This is available in an 
Ender 3. But the printer is equipped with a flexible printing plate as standard. By bending it slightly, 
practically any product can be easily removed.  
 
A disadvantage of the printing plate is that it produces a rough underside. When printing with PLA, a glass 
plate is therefore recommended as a base. This is always absolutely flat. It also ensures that the underside 
of the print is mirror smooth. In order to create a sufficiently stable adhesive base, use a 3D printer glue 
stick to coat the glass plate prior to printing. 
 
Of course, it is always advisable to find out exactly which PLA filament you want to order. This applies 
especially to the temperature range. It is quite possible that one or the other manufacturer will state a 
deviation here that is outside the maximum temperature of Ender 3. 
 
The low melting temperature of the filament reacts sensitively to trapped heat. Especially the gears in 
the feed can heat up so much in a closed housing that they reach the extrusion temperature of the 
material. Then your filament thread wraps around these gear wheels and does not reach the hot end tip 
anymore. This not only ruins the print but always results in costly repair and cleaning work.  
 
PolyLite™ Metallic PLA Pro 
Printing Temperature: 190˚C - 220˚C 
Bed Temperature: 30˚C - 60˚C 
Printing Speed: 30mm/s - 70mm/s 
Fan: ON 
 
Direct Drive: 
Retraction Distance: 1mm 
Retraction Speed: 30mm/s 
Indirect Drive: 
Retraction Distance: 3mm 
Retraction Speed: 60mm/s 



Printing with Silk PLA 
Silk PLA filament is a type of 3D printing material made by adding special additives (such as metallic 
particles) to PLA base material. Typically, Silk PLA has a shiny and silky appearance and also has a soft and 
smooth texture similar to silk fabric, so it is called: silk PLA. Compared to traditional PLA, Silk PLA has 
stronger inter-layer adhesion, resulting in a smoother and more delicate surface of the printed model and 
a more obvious silk-like feel. These characteristics make Silk PLA filament very popular; it can be used in 
a wide range of applications and is an excellent choice for producing high quality and more attractive 
looking prints. 
 
Below, you can find the Silk PLA settings that we recommend using with the Ender 3, which are the values 
that we have arrived at through our testing: 
Nozzle (Print) Temperature: 200 - 215 °C 
Bed Temperature: 60 °C  
Print Speed: 30 - 50 mm/s  (Slow down the printing speed to as low as 20 mm/s if you want the best 
surface finish.) 
Layer Height: 0.1 - 0.2 mm 
 
Some Other Recommended Silk PLA Slicer Settings 
Filament Drying 
Recommendation Temp:    55 °C 
Time:       2 – 4 hr 
 
Material  
Print temperature (+/- 5 °C based on hardware): 215 °C 
Printing temperature initial layer:   215 °C 
Initial printing temperature:   215 °C 
Final printing temperature:    60 °C 
Build plate temperature:    60 °C 
 
Speed  
Print speed:     50 mm/s 
Initial layer speed:    20 mm/s 
 
Optimize Wall Printing Order:  Open 
Flow:      95 - 100% 
 
Retraction  
Enable retraction:    Yes 
Retraction distance (direct drive):  0.8 mm 
Retraction distance (bowden):  5.5 mm 
Retraction speed:    40 - 45 mm 
Print Jerk:     8 mm/s 
 
Travel 
Combing mode:   Within Infill 
Retract before outer wall:  Yes 



Z hop when retracted:  No 
 
Cooling 
Fan speed:    100% 
Initial fan speed:   0% 
Regular fan speed at layer:  3 
Minimum layer time:   10s 
 
Build plate adhesion  
Build plate adhesion type:  Skirt 
Skirt line count:   3 
 
 
Printing with PETG 
PETG is a variant of polyethylene terephthalate. Basically, it is normal PET, as it is used for beverage 
bottles, with the addition of glycol. It combines the advantages of PLA and ABS. Printing is easy and the 
results are detailed and precise.  
 
PETG filament requires the following settings: 
Print temperature: 230 – 250 °C 
Bed temperature: For the first layers 110 °C, from 5 mm height it can be reduced to 70 °C.  
Plate adhesion: required, but in combination with a release agent 
Printing speed: 60 mm/s max. 
Retraction height: 5 – 7 mm 
Retraction speed: 40 mm/s minimum 
Cooling: required 
First layer height on the base plate: 0.3 mm 
 
PETG requires a very hot print. The printing temperature can be around 250 °C. However, most filament 
manufacturers have now set a processing temperature of 240 °C for this type. This is just within the 
temperature range with which the Ender 3 can work optimally.  
 
PETG also tends to warp. However, this is not as pronounced as with ABS filament. It is therefore 
sufficient to let the first layers adhere securely and straight through a hot adjusted printing plate. 
Afterward, the temperature can be reduced without any problems. This not only saves expensive 
electricity but also makes handling safer.  
 
The ideal combination for the adhesive/release layer is blue painter’s tape and hair spray. During printing, 
the solid then adheres sufficiently firmly. However, it can be easily removed after completion.  
 
PETG can be printed at up to 60 mm/s. However, you should only select this printing speed if you do not 
want to place high demands on the outer contour and strength. With a 50% reduction in speed, you will 
get much better results. This doubles the time needed for printing but is better than wasting filament on 
an unsatisfactory result. 
 



PETG is a little bit tricky when it comes to the topic “retraction”. Due to its high processing temperature, 
it tends to drip and pull threads. At the same time, it cools down quickly. Too high a pullback quickly forms 
a drop on the hot end, which blocks the print. It is recommended that you determine the retraction 
individually for each project. It is always between 5 and 7 mm. Proceed in the same way step by step when 
selecting the retraction speed. Starting at 40 mm/s you can work your way to the optimum setting in 5 
mm/s increments. 
 
The quality of your print is significantly influenced by a powerful cooling system. With the fan turned on, 
the details can be seen more precisely. On the other hand, a switched-off fan ensures that the individual 
layers bond more firmly together. So, if you want to produce a detailed, aesthetic component, a switched-
on fan is recommended. But if you want to make a robust component for static applications, leave the fan 
off. The difference can be big.  
 
Always work with a base layer when printing with PETG. This should be applied as loosely as possible. So 
let your extruded thread glide from a height of about 0.3 mm onto the prepared heating plate without 
pressing it down. Only after you have applied a base layer, can you reduce the printing distance again. 
 
 
Printing with Foaming LW-PLA 
Creality quote “Yes, the Ender-3 V3 is compatible with 1.75 mm Light Weight PLA (LW-PLA) filaments. 
However, please note that Light Weight PLA foams and expands when printed, so it requires special 
print settings.” 
 
LW-PLA is a unique filament especially suited for RC flight and it’s the first filament of its kind. It uses 
an active foaming technology to achieve lightweight, low-density printed parts. At around 230 °C LW-PLA 
starts foaming and it increases its volume by nearly 3 times. Decreasing the material flow to 35% or 40% 
in your preferred slicer allows you to achieve very lightweight parts. 
 
How Does LW-PLA Work? 
LW-PLA is a PLA material mixed with a foaming additive that activates at elevated temperatures.  It will 
print much like standard PLA at lower temperatures (210 – 220 °C) but once you print above 230 °C the 
foaming technology activates.  This foaming effect becomes more aggressive as you continue to elevate 
the temperature.  The key to success when printing with LW-PLA is balancing between print temperature, 
speed, and flow rate.  Once your printer and slicer settings are dialed in, you should achieve parts that 
match the wall thickness of the designed part but are 35 - 40% the weight of the same part printed in 
traditional PLA. 
 
In order to print parts that are dimensionally accurate and as light as possible, you need to determine how 
much the material will expand with your printer at different print temperatures.  We do this by printing 
single perimeter test cubes at various temperatures and flow rates. 
(https://www.3daeroventures.com/s/LW-PLA-Test-Cube.STL ) Then follow the following steps to dial in 
your printer’s settings for LW-PLA. 
 
Step 1 
Print various cubes in 10 degree increments between 200 – 280 °C.  Use the following settings to print the 
supplied test cube: 



Bed Temp: 60 °C  
Speed: 30 - 40 mm/s  
Bottom Layers: 4 
Top Layers: 0 
Perimeter: 1 
Infill: 0% 
Cooling Fan: 0% for First Layer, up to 25% for subsequent layers 
 
Step 2 
Measure the wall thickness of each cube and note the temperature that gave you the cube with the 
thickest wall/highest expansion. 
 
Now, print various cubes, all at the same print temperature you determined in Step 2, but each cube at a 
different flow percentage.  Print the first cube at 90% flow, then step down by 10% for each cube until 
your last cube is printed at 30% flow.  Note that Cura calls this setting “Flow” and it is entered as a 
percentage and Simplify3D calls this setting “Extrusion Multiplier” and it is entered as a decimal value 
(e.g. 0.4 instead of 40%) 
 
Measure the wall thickness of each cube and find the one that matches the nozzle diameter you are 
printing with.  If you are printing with a 0.4mm nozzle then the wall thickness of your perfectly optimized 
cube should measure 0.4 mm.  
  
Foaming LW-PLA slicer settings: 
Nozzle Temperature Suggested Range: 210 – 260 °C 
Effect of Temperature: Lower temperatures (around 210 – 220 °C) yield minimal foaming, resulting in 
denser prints. Higher temperatures (250 °C+) significantly increase the foaming effect, which is ideal for 
lightweight parts but can sacrifice some surface detail. 
 
Bed Temperature Suggested Range: 40 – 60 °C 
Bed Adhesion: LW-PLA generally adheres well to a heated bed set around 50 °C. If your prints have trouble 
sticking, consider adding a thin layer of glue stick or using a textured build surface. 
 
Print Speed Suggested Range: 30 - 60 mm/s 
Optimal Speed: Printing at slower speeds, like 30 - 40 mm/s, helps manage the foaming process and ensures 
better print quality. Faster speeds may work but can lead to inconsistencies in extrusion due to rapid 
foaming. 
 
Layer Height Suggested Range: 0.1 - 0.3 mm 
Considerations: A smaller layer height will yield finer details but may increase print time. For larger, less 
detailed models, a 0.2 - 0.3 mm layer height is suitable. 
 
Retraction Settings Retraction Distance: 3 - 6 mm for Bowden setups, 1 - 2 mm for direct drive 
Retraction Speed: 20 - 40 mm/s 
Tips: Since LW-PLA tends to be more susceptible to stringing due to foaming, fine-tuning retraction 
settings are crucial to reduce unwanted stringing. 
 



Cooling Fan Speed: 0 - 50% 
Recommendations: To control foaming, it’s often best to print with reduced fan speeds or even turn off 
cooling entirely. Too much cooling can lead to brittle foamed parts, while minimal cooling ensures smoother 
extrusion. 
 
As a reference, we have had great success printing LW-PLA with the following settings: 
Nozzle Temp: 250 °C 
Flow Rate (Extrusion Multiplier): 40% (0.4) 
Speed: 40 mm/s 
 
Tips for Optimal LW-PLA Printing 
Printing with LW-PLA requires a bit of experimentation to get the ideal balance between weight and 
quality. Here are some advanced tips to help you master printing with this filament: 
 
1. Experiment with Temperature for Desired Foaming 
Different models and applications call for varying levels of foaming. If you want a more solid part, use a 
lower temperature (210-220°C). For maximum weight reduction, increase the temperature gradually to 
240-250°C but monitor your print for any signs of over-foaming. 
 
2. Adjust the Flow Rate 
Because of LW-PLA’s expansion properties, you can reduce the flow rate to save material. For instance, if 
you’re printing at a high foaming temperature, reducing the flow rate by 20-50% can still yield a full-size 
part without excess material. 
 
3. Use Lower Infill for Lightweight Parts 
In most cases, you can use an infill percentage as low as 10-20%, especially for parts where structural 
integrity is less critical. However, keep in mind that foamed parts can be more fragile than dense prints, 
so choose infill settings based on your part’s functional requirements. 
 
4. Post-Processing Possibilities 
LW-PLA prints can be post-processed similarly to standard PLA. You can sand, paint, or even add finishes 
to achieve a smooth and professional look. Due to its foamed nature, LW-PLA is often easier to sand, which 
can be advantageous for detailed projects. 
 
Troubleshooting Common Issues with LW-PLA 
Over-Foaming 
If you notice that your print is excessively foamed and lacks detail, try lowering the print temperature. 
Start with small temperature adjustments, like reducing by 5°C at a time, until you achieve the desired 
texture. 
 
Stringing and Blobs 
LW-PLA can be prone to stringing due to its foaming characteristics. Adjusting retraction distance and 
speed can help, as can lowering the print temperature slightly. Running a series of stringing tests may be 
helpful to fine-tune these settings. 
 
Inconsistent Extrusion 



If you experience inconsistent extrusion, it may be due to rapid expansion in the filament. Slowing down 
your print speed and reducing the flow rate can provide more consistent results. Also, ensure that the 
filament path in your extruder is free from obstructions. 
  



Creality Print 6.2 Settings for Ender-3 V3 with Polylight 1.0 LW-PLA using 0.4mm Nozzle 
 

 
 



 



 



   



   



   



 
 
 
 
Recommended Settings for eSun eLW-PLA 
Temperature Settings: 
Printing Temperature: 235°C 
Build Plate Temperature: 60°C 
 
Flow Rates: 
Set the flow rate to 100% for standard prints. Adjust as necessary based on your printer's calibration 
and the specific model being printed. 
 



Print Speed: 
Print Speed: 100 mm/s 
Outer Wall Speed: 40 mm/s 
Inner Wall Speed: 40 mm/s 
Travel Speed: 80 mm/s 
 
Layer Height: 
Layer Height: 0.25 mm 
Line Width: 0.4 mm 
 
Infill and Shell Settings: 
Infill Density: 0% (for lightweight prints, adjust as needed for strength) 
Wall Line Count: 1 
 
Retraction Settings: 
Enable Retraction: Checked 
Retraction Distance: 2 mm 
Retraction Speed: 30 mm/s 
 
Cooling Settings: 
Enable Print Cooling: Checked 
Fan Speed: 20% 
 
Additional Tips 
Calibration: Ensure your printer is well-calibrated, especially for flow rates and retraction settings, as 
LW-PLA can be sensitive to these parameters. 
 
Single Part Printing: It is recommended to print one part at a time to minimize stringing and improve print 
quality. 
 
Foaming Behavior: Be aware that eSun PLA-LW foams during printing, which can affect the final dimensions 
of your print. Adjust settings accordingly to achieve the desired results.  
 
By following these settings and tips, you should be able to achieve high-quality prints with eSun PLA-LW 
filament, suitable for lightweight applications such as model aircraft. 
 
 
Active Foaming LW-PLA Settings (Cura) 
Quality 
Layer Height     0.25 mm 
Initial Layer Height    0.25 mm 
Line Width     0.4 mm 
Wall Line Width    0.4 mm 
Outer Wall Line Width   0.4 mm 
Inner Wall(s) Line Width   0.4 mm 
Top/Bottom Line Width   0.4 mm 



Infill Line Width    0.4 mm 
Skirt/Brim Line Width   0.4 mm 
Initial Layer Line Width   100% 
 
Walls 
Wall Thickness    0.4 mm 
Wall Line Count    1 
Outer Wall Wipe Distance   0.0 mm 
Outer Wall Inset    0.0 mm 
Optimize Wall Printing Order  膆 
Wall Ordering    Inside to Outside 
Alternate Extra Wall    
Print Thin Walls    膆 
Horizontal Expansion    0.0 mm 
Initial Layer Horizontal Expansion  0.0 mm 
Hole Horizontal Expansion   0.0 mm 
Z Seam Alignment    Sharpest Corner 
Seam Corner Preference   Smart Hiding 
 
Top/Bottom 
Top Surface Skin Layers   0 
Top/Bottom Thickness   0.75 mm 
Top Thickness    0.75 mm 
Top Layers     3 
Bottom Thickness    0.75 mm 
Bottom Layers    3 
 
Top/Bottom Pattern Lines 
Bottom Pattern Initial Layer  Lines 
Monotonic Top/Bottom Order   
Top/Bottom Line Directions    
No Skin in Z Gaps     
Extra Skin Wall Count   1 
Enable Ironing     
Skin Overlap Percentage   10% 
Skin Overlap     0.04 mm 
Skin Removal Width    0.4 mm 
Top Skin Removal Width   0.4 mm 
Bottom Skin Removal Width   0.4 mm 
Skin Expand Distance   0.4 mm 
Top Skin Expand Distance   0.4 mm 
Bottom Skin Expand Distance  0.4 mm 
Maximum Skin Angle for Expansion  90° 
Minimum Skin Width for Expansion  0.0 mm 
 
Infill (Gyroid)  



Infill Density     3% 
Infill Line Distance    13.333 mm 
Infill Pattern     Gyroid 
Connect Infill Lines     
Randomize Infill Start    
Infill Line Multiplier    1 
Extra Infill Wall Count   0 
Infill Overlap Percentage   10% 
Infill Overlap     0.04 mm 
Infill Wipe Distance    0.1 mm 
Infill Layer Thickness   0.25 mm 
Gradual Infill Steps    0 
Infill Before Walls     
Infill Minimum Area    0.0 mm 
Infill Support      
Skin Edge Support Thickness  0.0 mm 
Skin Edge Support Layers   0 
 
Infill (Cubic Subdivision) 
Infill Density     3% 
Infill Line Distance    40.0 mm 
Infill Pattern     Cubic Subdivision 
Infill Line Directions     
Randomize Infill Start    
Infill Line Multiplier    1 
Cubic Subdivision Shell   0.4 mm 
Infill Overlap Percentage   10% 
Infill Overlap     0.04 mm 
Infill Wipe Distance    0.1 mm 
Infill Layer Thickness   0.25 mm 
Gradual Infill Steps    0 
Infill Before Walls     
Infill Minimum Area    0.0 mm 
Infill Support      
Skin Edge Support Thickness  0.0 mm 
Skin Edge Support Layers   0 
 
Material 
Printing Temperature   235 °C 
Printing Temperature Initial Layer  235 °C 
Initial Printing Temperature  235 °C 
Final Printing Temperature   235 °C 
Build Plate Temperature   60 °C 
Build Plate Temperature Initial Layer 60 °C 
Scaling Factor Shrinkage Compensation 100% 
Horizontal Scaling Factor Shrinkage Compensation  100% 



Vertical Scaling Factor Shrinkage Compensation 100% 
Flow      60% 
Wall Flow     60% 
Outer Wall Flow    60% 
Inner Wall(s) Flow    60% 
Top/Bottom Flow    60% 
Infill Flow     60% 
Skirt/Brim Flow    60% 
Prime Tower Flow    60% 
Initial Layer Flow    80% 
 
Speed 
Print Speed     60 mm/s 
Infill Speed     60 mm/s 
Wall Speed     30 mm/s 
Outer Wall Speed    30 mm/s 
Inner Wall Speed    30 mm/s 
Top/Bottom Speed    30 mm/s 
Travel Speed     120 mm/s 
Initial Layer Speed    30 mm/s 
Initial Layer Print Speed   30 mm/s 
Initial Layer Travel Speed   120 mm/s 
Skirt/Brim Speed    30 mm/s 
Number of Slower Layers   2 
Flow Equalization Ratio   100% 
Enable Acceleration Control    
Enable Jerk Control     
 
Travel 
Enable Retraction    膆 
Retract at Layer Change    
Retraction Distance    0.0 mm 
Retraction Speed    35 mm/s 
Retraction Retract Speed   35 mm/s 
Retraction Prime Speed   35 mm/s 
Retraction Extra Prime Amount  0.3 mm 
Retraction Minimum Travel   1.5 mm 
Maximum Retraction Count   90 
Minimum Extrusion Distance Window 6.5 mm 
Combing Mode    All 
Avoid Supports When Traveling  膆 
Travel Avoid Distance   0.625 mm 
Layer Start X    0.0 mm 
Layer Start Y     0.0 mm 
Z Hop When Retracted    
 



Cooling  
Enable Print Cooling     
Regular/Maximum Fan Speed Threshold 10 s 
Regular Fan Speed at Height  0.27 mm 
Regular Fan Speed at Layer   2 
Minimum Layer Time    2.0 s 
Maximum Speed    10 mm/s 
Lift Head      
 
Support 
Generate Support     
Build Plate Adhesion  
Build Plate Adhesion Type   Brim 
Skirt/Brim Minimum Length   250 mm 
Brim Width     8.0 mm 
Brim Line Count    20 
Brim Distance     0.0 mm 
Brim Only on Outside   膆 
 
 

 
Printing with Pre-Foamed LW-PLA 
I purchased a roll of Bright Yellow Polymaker Light Weight PLA Filament from Amazon, where you can find 
this on the web @:  https://www.amazon.com/dp/B0B1DGJSTQ/?tag=lstir-20&th=1. The features of this 
Pre-Foamed filament are captured in the next few paragraphs below. 
Lightweight PLA: Polymaker LW-PLA filament has a low density of 0.9g/cm³, compared to 1.17g/cm³ for 
standard PLA. It uses the same printing settings as regular PLA, ensuring easy compatibility with most 
3D printers. Unlike the traditional foaming LW-PLA, Polymaker LW-PLA does not foam during printing, 
preventing common foaming issues. Compared with the filament of Foaming-When-Printing, it has higher 
printing density stability and is better at suppressing stringing. 
High Rigidity & Good Layer Adhesion: Polymaker LW-PLA filament provides high rigidity and excellent 
layer adhesion, making it ideal for creating stiff parts for radio-controlled planes. This reliable LW-PLA 
features great bed adhesion, consistent color, and dimensional accuracy, while eliminating issues like 
warping, jamming, blobs, and layer delamination. Note: Turn off the fan for the first layer to improve 
bed adhesion. 
7 Colors Available & Matte Finish: Polymaker LW-PLA is available in white, black, grey, wood, bright yellow, 
bright orange, and bright green. It produces a matte surface finish that conceals layers and is easy to 
paint. 
Tangle-Free & Moisture-Free: Polymaker LW-PLA filament is meticulously wound to prevent tangling and 
is dried and vacuum-sealed in a resealable Ziplock bag with a desiccant. Always hold the filament tip to 
avoid nodes and utilize the spool holes to help prevent tangling. 
Pre-Foamed LW-PLA Printing Settings: Printing Temperature: 190 – 210˚C; Bed Temperature: 30 – 50˚C; 
Printing Speed: 25 – 60 mm/s; Fan: ON; For Direct Drive: Retraction Distance: 3 mm; Retraction Speed: 
40 mm/s; For Indirect Drive: Retraction Distance: 6 mm; Retraction Speed: 60 mm/s 
 



Here's a helpful video on Pre-Foamed LW-PLA: https://youtu.be/eDBtZeIY5aE. It seems like a happy 
medium between foaming LW-PLA and standard PLA in both strength and weight, as in it is stronger than 
foaming LW-PLA it seems, and lighter than standard PLA, but not quite as light as the ColorFab LW-PLA. 
However, it is allegedly very easy to print, and at a lower price. 
 
Another source of pre-foamed LW-PLA is OVERTURE Air PLA Filament, Pre-Foamed PLA Low-Density 
(0.82g/cm³), which you can also purchase on Amazon @: https://www.amazon.com/OVERTURE-Filament-
Cardboard-Dimensional-Probability/dp/B0BQRG6FBW/?th=1.   
 
Overture Air Filament settings for the Ender-3 V3 with a 0.4 nozzle: 

All Flow Ratios: 120% 
Recommended Nozzle Temperature: 190 – 210˚C 
Nozzle Print Temperatures: 

First Layer - 210˚C 
Other Layers - 190˚C 

Smooth PEI Plate / High Temp Plate (bed) Temperatures: 
First Layer: 65˚C 
Other Layers: 60˚C 

Fan Cooling: 
 No cooling for first layer 
 Model fan speed @ 2nd layer w/ 10% min fan speed & 25% max fan speed 
For Direct Drive: 

Retraction Distance: 3.5 mm 
Retraction Speed: 35 mm/s 
Extra length on restart: 0.35mm 

 
Layer Height: 0.20 mm 
 First layer height: 0.25 mm 
Line Width: 0.30 mm 
 
First Layer & Infill Speed: 15 mm/s 
Other Layers Speed: 30 – 50 mm/s 
 
Top Shell Layers: 4 @ 1mm 
Bottom Shell Layer: 3 @ 1mm 
Sparse Infill Density: 5% 
Sparse Infill Pattern: Gyroid 
Enable Support: use Tree(auto) Type and Organic Style 
Brim: Outer Brim Only 
Travel speed: 250 mm/s 
Acceleration: 750 mm/s² 
 
 
Prefoamed LW-PLA Settings (Cura) 
Quality 
Layer Height     0.25 mm 



Initial Layer Height    0.25 mm 
Line Width     0.4 mm 
Wall Line Width    0.4 mm 
Outer Wall Line Width   0.4 mm 
Inner Wall(s) Line Width   0.4 mm 
Top/Bottom Line Width   0.4 mm 
Infill Line Width    0.4 mm 
Skirt/Brim Line Width   0.4 mm 
Initial Layer Line Width   100% 
 
Walls 
Wall Thickness    0.4 mm 
Wall Line Count    1 
Outer Wall Wipe Distance   0.0 mm 
Outer Wall Inset    0.0 mm 
Optimize Wall Printing Order  膆 
Wall Ordering    Inside to Outside 
Alternate Extra Wall    
Print Thin Walls    膆 
Horizontal Expansion    0.0 mm 
Initial Layer Horizontal Expansion  0.0 mm 
Hole Horizontal Expansion   0.0 mm 
Z Seam Alignment    Sharpest Corner 
Seam Corner Preference   Smart Hiding 
 
Top/Bottom 
Top Surface Skin Layers   0 
Top/Bottom Thickness   0.75 mm 
Top Thickness    0.75 mm 
Top Layers     3 
Bottom Thickness    0.75 mm 
Bottom Layers    3 
 
Top/Bottom Pattern Lines 
Bottom Pattern Initial Layer  Lines 
Monotonic Top/Bottom Order   
Top/Bottom Line Directions    
No Skin in Z Gaps     
Extra Skin Wall Count   1 
Enable Ironing     
Skin Overlap Percentage   10% 
Skin Overlap     0.04 mm 
Skin Removal Width    0.4 mm 
Top Skin Removal Width   0.4 mm 
Bottom Skin Removal Width   0.4 mm 
Skin Expand Distance   0.4 mm 



Top Skin Expand Distance   0.4 mm 
Bottom Skin Expand Distance  0.4 mm 
Maximum Skin Angle for Expansion  90° 
Minimum Skin Width for Expansion  0.0 mm 
 
Infill (Gyroid)  
Infill Density     3% 
Infill Line Distance    13.333 mm 
Infill Pattern     Gyroid 
Connect Infill Lines     
Randomize Infill Start    
Infill Line Multiplier    1 
Extra Infill Wall Count   0 
Infill Overlap Percentage   10% 
Infill Overlap     0.04 mm 
Infill Wipe Distance    0.1 mm 
Infill Layer Thickness   0.25 mm 
Gradual Infill Steps    0 
Infill Before Walls     
Infill Minimum Area    0.0 mm 
Infill Support      
Skin Edge Support Thickness  0.0 mm 
Skin Edge Support Layers   0 
 
Infill (Cubic Subdivision) 
Infill Density     3% 
Infill Line Distance    40.0 mm 
Infill Pattern     Cubic Subdivision 
Infill Line Directions     
Randomize Infill Start    
Infill Line Multiplier    1 
Cubic Subdivision Shell   0.4 mm 
Infill Overlap Percentage   10% 
Infill Overlap     0.04 mm 
Infill Wipe Distance    0.1 mm 
Infill Layer Thickness   0.25 mm 
Gradual Infill Steps    0 
Infill Before Walls     
Infill Minimum Area    0.0 mm 
Infill Support      
Skin Edge Support Thickness  0.0 mm 
Skin Edge Support Layers   0 
 
Material 
Printing Temperature   210 °C 
Printing Temperature Initial Layer  210 °C 



Initial Printing Temperature  210 °C 
Final Printing Temperature   210 °C 
Build Plate Temperature   60 °C 
Build Plate Temperature Initial Layer 60 °C 
Scaling Factor Shrinkage Compensation 100% 
Horizontal Scaling Factor Shrinkage Compensation  100% 
Vertical Scaling Factor Shrinkage Compensation 100% 
Flow      100% 
Wall Flow     100% 
Outer Wall Flow    100% 
Inner Wall(s) Flow    100% 
Top/Bottom Flow    100% 
Infill Flow     100% 
Skirt/Brim Flow    100% 
Prime Tower Flow    100% 
Initial Layer Flow    100% 
 
Speed 
Print Speed     60 mm/s 
Infill Speed     60 mm/s 
Wall Speed     30 mm/s 
Outer Wall Speed    30 mm/s 
Inner Wall Speed    30 mm/s 
Top/Bottom Speed    30 mm/s 
Travel Speed     120 mm/s 
Initial Layer Speed    30 mm/s 
Initial Layer Print Speed   30 mm/s 
Initial Layer Travel Speed   120 mm/s 
Skirt/Brim Speed    30 mm/s 
Number of Slower Layers   2 
Flow Equalization Ratio   100% 
Enable Acceleration Control    
Enable Jerk Control     
 
Travel 
Enable Retraction    膆 
Retract at Layer Change    
Retraction Distance    6.0 mm 
Retraction Speed    50 mm/s 
Retraction Retract Speed   50 mm/s 
Retraction Prime Speed   50 mm/s 
Retraction Extra Prime Amount  2.0 mm 
Retraction Minimum Travel   1.5 mm 
Maximum Retraction Count   100 
Minimum Extrusion Distance Window 5.0 mm 
Combing Mode    All 



Avoid Supports When Traveling  膆 
Travel Avoid Distance   0.625 mm 
Layer Start X    0.0 mm 
Layer Start Y     0.0 mm 
Z Hop When Retracted    
 
Cooling  
Enable Print Cooling    膆 
Fan Speed     100% 
Regular Fan Speed    100% 
Maximum Fan Speed    100% 
Regular/Maximum Fan Speed Threshold 10 s 
Initial Fan Speed    0.0% 
Regular Fan Speed at Height  0.9 mm 
Regular Fan Speed at Layer   10 
Minimum Layer Time    5.0 s 
Maximum Speed    15 mm/s 
Lift Head      
 
Support 
Generate Support     
Build Plate Adhesion  
Build Plate Adhesion Type   Brim 
Skirt/Brim Minimum Length   250 mm 
Brim Width     8.0 mm 
Brim Line Count    20 
Brim Distance     0.0 mm 
Brim Only on Outside   膆 
 
  



Printing with TPU 
https://the3dprinterbee.com/3d-printing-with-tpu-properties-tipps-best-settings/  
 
TPU is short for Thermoplastic Polyurethane and is a flexible filament. Flexible materials are suitable for 
numerous printing projects (like main landing gear and tailwheel tires) due to their elasticity. 
 
Here are the most important TPU settings (compatible with Cura, PrusaSlicer, Creality Slicer and many 
other slicers): 
Setting   Value 
Nozzle Size:   0.4 - 0.6 mm (0.6mm nozzle can help reduce clogging & ensure smoother 
extrusion) 
Print temperature:  210 - 230 °C 
Print bed temperature: 50 - 60 °C 
Print speed:   20 - 30 mm/s 
Flow Rate:   95 - 105% 
Z-Hop:    Enable the Z-hop option and set it to 0.2 - 0.4 mm lift 
Retraction distance:  0.5 - 2 mm  
Retraction speed:  20 mm/s 
Retraction Min. Travel: 1.5 mm 
Layer height:   25 - 50% of the nozzle diameter (i.e. 0.1 to 0.2 mm with a 0.4 mm nozzle) 
Line width:   80 - 100% of the nozzle diameter (i.e. 0.32 to 0.4 mm for a 0.4 mm nozzle) 
Infill density:   20 - 30%. The higher the stiffer. 
Infill pattern:  Gyroid, concentric 
Extruder:   Direct drive extruder 
Cooling    0% (10 - 50% for overhangs) 
Storage:   Airtight (vacuum bag, plastic box) 
Print bed:   PEI* and isopropyl alcohol for loosening, blue tape, no raft. 
Enclosure necessary? No 
Nozzle:   Bigger is better with Bowden extruders 
 
Through the infill pattern, you can influence the stiffness of the object in different directions. For 
example, the gyroid pattern is equally stable in all spatial directions, which also makes the finished TPU 
object evenly flexible. If you want to make one axis of the object more stable than the other two, you can 
use the concentric infill pattern. It consists of circles formed around one axis. This gives a relatively low 
stability along the main axis and almost none along the other two. 
 
Due to the flexible nature of TPU, it is also important where the coil is placed relative to the extruder 
and what the resistance is when the coil is unwound. If the extruder has to pull too hard on the filament, 
either because the spool is placed under the extruder or the spool does not have good bearings, the 
filament will be drawn stretched in the extruders. This can lead to under-extrusion. Many 3D printers 
have a rigid spool holder. Try replacing it with a holder that allows the spool to rotate easily. 
 
TPU has extremely good print bed adhesion to PEI. PEI print bed surfaces are available in various designs. 
They are smooth or rough, flexible or inflexible. Whether the print bed is flexible is not all that important 
with TPU, since the flexibility would be compensated for by TPU anyway and you wouldn’t be able to release 
the object any better by flexing the print plate. TPU often adheres too well to PEI, so it can be difficult 



to remove the object from the print bed after printing. However, if you apply isopropyl alcohol generously 
to the base of the object, the TPU object will come off easily. Even large objects can be easily removed 
without leaving any residue. Another option and to increase (or in the case of PEI slightly decrease) the 
print bed adhesion for TPU is to use Blue Tape. This tape has a roughened surface and provides good 
adhesion. The downside is that you’ll have to replace it after a few prints. 
 
 
Multicolor 3D Printing with a Single Extruder 
 
Pause at Height and Swap Filament 
One of the most common ways to print 3D with multiple colors is to pause the print and to manually swap 
out the filament with another filament of a different color. Often this is done when the printer increases 
its Z position to move to a new layer. It is often referred to as the pause at height or pause at layer 
method. You are not limited to swapping filament colors only once; it is possible to swap filaments many 
times during a single print to create cool visuals. You can either pause the 3D printer by hand or edit the 
G-code so that the 3D printer pauses automatically at specific points during the print.  
 
Edit G-code to Pause the Print 
If you need more precise control, for example, if you want to swap filament on a layer change, it is best 
to edit the G-code of the print. This causes the printer to automatically interrupt the print and enter a 
pause state. One advantage of this method is that there is no need to monitor the 3D printer. Once the 
printer reaches a specific layer that you want to swap the filament at, it does the pause without any human 
input. Editing the G-code involves inserting pause commands. You can do this by hand, or you can have the 
slicer software do it for you. 
 
How to Manually Edit G-code to Pause a Print 
To manually edit G-code to set up a 3D print for automatic pausing, you can do the following: 
1. First, find in your slicing software the exact layer(s) you want to swap colors at. 
2. Generate the regular G-code for the print and open it in a text editor like Notepad. 
3. Edit the G-code by adding pause commands. For example, the G-code I add to pause the print is as 
follows: 

G91  ; set relative positioning 
G1 Z10 F4000 ; move Z up 10mm 
G90  ; set absolute positioning 
M600  ; suspend/pause 

This moves the nozzle up 10mm and then pauses the print. I let the hotend move upwards first so that any 
filament that oozes out of the nozzle will be in mid-air instead of oozing on the print. 
 
In the example from before, where I want to pause the print at Z2.20, the resulting section of G-code 
would look something like this: 

G92 E0.0000 
G1 E-1.7000 F3000 
; layer 11, Z = 2.200 
G91  ; set relative positioning 
G1 Z10 F4000 ; move Z up 10mm 
G90  ; set absolute positioning 



M600  ; suspend/pause 
; feature outer perimeter 
G1 Z2.200 F300 
G1 X-2.589 Y3.860 F12000 

So, what I did there was insert the pause G-code right before the command that moves the 3D printer to 
Z2.20 (G1 Z2.200 F300). 
 
For the Ender-3 V3 using Creality Print: Simply insert the word PAUSE following the line of code for 
the ;LAYER: you wish to complete with the OLD color. The printer will pause AFTER that layer finishes 
and allow you to manually change the filament using “Retract” followed by “Extrude” commands on the 
touch screen. When the NEW filament is ready to go and you have manually removed the thin strands of 
filament from the nozzle during the Retract/Extrude routine, hit HOME and then RESUME. The printer 
will move to its last location and begin printing with the NEW color. 
 
I use this on my Ender-3 V3’s: 
Right click in the slicer where you want to add a pause: 

 
 
This is the code that’s added. (After you add the pause reslice to make sure it’s written in the code.) 
Pause-Test 
Pause-Test 
294×121 5.83 KB 
While it’s paused you can change filaments using Extrude/Retract as usual. Bed temp will remain hot, but 
the nozzle will cool. 
 
How to Automatically Insert Pause Commands in G-Code 
Aside from manually editing G-code, it is also possible to have the slicer software automatically insert 
pause commands when the G-code for the print is generated. This saves quite a bit of time and effort 



when you want to pause a print several times. Slicers usually do this by running a post-processing script 
after generating the G-code. This script inserts the pause commands at the relevant locations. 
 
Post-Processing in Other Slicers 
Other slicers have their own implementation of post-processing scripts. For example, Cura has a built-in 
post-processing script for pausing at specific heights, whereas Slic3r supports external post-processing 
scripts in a variety of languages such as Perl, Python, Ruby and Bash. 
 
In short, you need to insert the right post-processing script in your slicer, and make sure that the G-code 
in the script is correct for your specific 3D printer. In many cases you will be able to find an example 
pause at layer height script online for your 3D printer that you can use. After setting the right layer 
heights in the script, you will be able to pause 3D prints at the exact height you want. 
 
How to Change Filament Colors After Pausing the Print 
After pausing the print, whichever method you use, the next step is to change to a different filament 
color. Let’s see how to do that. 
Before swapping the filament, make sure that the hotend is heated to the extrusion temperature. It is 
important for the filament in the nozzle is melted, otherwise you might not be able to pull it out. 

1. To unload the old filament, press the extruder lever to disengage the drive gear, and use your other 
hand to pull the filament out. Alternatively, use the printer control panel or host software to 
reverse the filament out mechanically. 

2. To load the new filament, press the extruder lever once again, and insert the new filament as far 
as possible. Make sure that the filament passes the extruder drive gear, before releasing the lever. 

3. Purge the old filament from the hotend. I find the best way to do this is to extrude using the 
printer’s control panel or host software. 

Once the color of the extruded filament is the same as the filament going into the hotend, you can resume 
the print. Make sure to remove any strings of extruded filament from the nozzle with a pair of tweezers 
first. 
To resume the print, once again use the printer’s control panel or the host software. 
 
Additional Considerations 
Make sure to keep the hotend hot during pausing. This allows you to pull all of the old filament out. 
The same goes for the heated bed. If you are using one, make sure that it does not cool down while the 
printer is paused. This can cause the part(s) to be released, ruining your print. 
It is also important to keep the stepper motors of your 3D printer on/engaged while the print is paused, 
so that the hotend can resume printing from the exact X/Y coordinates it paused at. Turning the stepper 
motors off makes it possible for the extruder carriage to move. If it moves, the print will shift on the 
next layer after resuming. 
You can often set the pause behavior for the three above items in the printer’s firmware. That way you 
don’t need to set them manually every time you pause a print. 
 
 
 
 
 
 



Editing STL Files using Fusion 360 
 
Step 1: Import STL File 
Click on the + button on the top bar to pick a new design. 
Click on the Create button from the menu bar and a drop-down menu will be displayed. 
By clicking on the Create Base Feature from the drop-down menu, it will turn off all the extra features 
and design history will not be recorded. 
Click on the Insert > Insert Mesh, browse your STL file, and open to import it. 
 
Step 2: Edit & Modify STL File 
Once the file is imported, an Insert Design box will appear on the right side to change your model’s position 
using a mouse or inserting numerical inputs. 
Right-click on the model and click on Mesh to BRep > OK to convert it into a new body. 
Click on Model > Patch from the top left corner to remove unnecessary facets. 
Click Modify > Merge, select the facets you want to remove and click 
Click on Finish Base Feature to go back into regular mode. 
Click Modify > Change Parameters, click the + button, and modify parameters as you want. 
Click on Sketch and put a center using angles. 
Go to Create > Pattern > Pattern on Path, modify the settings and parameters according to your need. 
 
Step 3: Export STL File 
Go to the save icon on the top bar, give a name to your file and click 
Go to the left side window, Right Click > Save as STL > OK > Save. 
 
Check out the video below for a tutorial for modifying STL files. 
https://youtu.be/DWv2uK-XpA4 
 
Converting a Mesh to a Solid in Fusion 360 

1. Open Fusion 360 and go to the File menu. 
2. Select Open and import the desired STL file. 
3. Switch to the Mesh workspace by selecting it from the top toolbar. 
4. Use the Prepare tools in the Mesh toolbar to clean up or repair the mesh body. 
5. If needed, convert the mesh to a solid body by selecting Modify > Convert Mesh. 
6. Choose the BRep option to convert the mesh into a solid for further editing. 
7. Use the Modify tools (e.g., Extrude, Cut, or Fillet) to make changes to the solid body. 
8. Save your edited file by selecting File > Save As and choosing the desired format. 

 
Converting a Mesh to a Solid in Fusion 360 

1. Open the Design workspace in Fusion 360. 
2. Click on the Mesh tab in the toolbar. 
3. Select Modify > Convert Mesh. 
4. In the canvas, select the mesh body you want to convert. 
5. In the Convert Mesh dialog, choose an Operation: Parametric: Maintains upstream parametric 

relationships. Base Feature: Does not maintain upstream parametric relationships. 



6. Choose a Method: Faceted: Converts each face of the mesh to a corresponding face on the solid 
body. Prismatic: Merges groups of faces into singular faces for prismatic features. Organic: 
Converts the mesh into an organically shaped solid (requires Fusion Design Extension). 

7. Adjust additional settings if needed: For Organic, select a Resolution (e.g., Low, Medium, High, 
Precise) or specify the Number of Faces. Optionally, check Preprocess Holes to refine open hole 
boundaries. 

8. Click OK to complete the conversion. 
Tips for Best Results: 

 Ensure the mesh has fewer than 10,000 facets to avoid conversion issues. 
 Use tools like Repair, Generate Face Groups, and Direct Edit to refine the mesh before 

conversion. 
If the mesh is watertight, it will convert to a solid body. Otherwise, it will convert to a surface body, 
which can be stitched into a solid using surface modeling tools. 
 
 
  



3D Model a Canopy Step-by-Step Workflow in Fusion 360 
Gather References: 
Import side/top view drawings or blueprints of your RC airplane into Fusion 360. 
Scale them to match your fuselage dimensions. 
 
Create Base Sketches: 
Draw the canopy outline on the fuselage using the Sketch tool. 
Define cross-sections (front, middle, rear) to capture the canopy’s curvature. 
 
Use Loft or Sweep: 
Apply the Loft tool between multiple profiles to generate the canopy’s curved surface. 
Alternatively, use Sweep if you have a guiding path for the canopy’s arc. 
 
Refine the Shape: 
Use Fillet to smooth sharp edges. 
Apply Surface Patch or Surface Trim to clean up transitions between canopy and fuselage. 
 
Hollow the Canopy: 
Use the Shell tool to create a thin-walled canopy suitable for 3D printing. 
Adjust thickness depending on material strength (usually 1–2 mm for lightweight RC parts). 
 
Add Details: 
Model framing lines or cutouts for cockpit visibility. 
Use Split Body if you want detachable canopy sections. 
 
Prepare for Printing: 
Export as STL. 
Orient the canopy in your slicer for minimal supports and best surface finish. 
 
Pro Tips: 
Symmetry: Use the Mirror tool to ensure both sides of the canopy are identical. 
Fit Check: Model the canopy as a separate body so you can test-fit it digitally with the fuselage. 
Printing Strategy: Consider printing the canopy in clear PETG or resin for transparency. 
 
Step-by-Step Bubble Canopy Example 
Set Up Reference Geometry: 
Open Fusion 360 and create a new component called Canopy. 
Import or sketch the fuselage outline (side view) so you know where the canopy will sit. 
 
Sketch the Canopy Base: 
On the Top Plane, sketch an oval or rounded rectangle that matches the footprint of the canopy on the 
fuselage. 
This will be the bottom edge of your canopy. 
 
Create Cross-Section Profiles: 
On the Front Plane, sketch a curved profile (like a dome shape). 



On the Mid Plane (halfway along the canopy length), sketch another profile, slightly flatter. 
On the Rear Plane, sketch a smaller curve tapering down to meet the fuselage. 
 
Loft the Canopy: 
Use the Loft tool: select the front, mid, and rear profiles. 
This generates a smooth bubble canopy surface. 
 
Refine the Shape: 
Apply Fillet to soften edges where the canopy meets the fuselage. 
If needed, use Surface Patch to close gaps and then Stitch to make it a solid body. 
 
Hollow the Canopy: 
Use the Shell tool to hollow the canopy to ~1.5 mm thickness. 
This makes it lightweight and printable. 
 
Add Details: 
Sketch canopy framing lines (thin ribs) and extrude them slightly. 
Use Split Body if you want the canopy detachable. 
 
Prepare for Printing: 
Export as STL. 
Orient canopy upside down in slicer for best surface finish. 
 
Advanced Detailing Steps 
Add Canopy Framing: 
Create a new sketch on the canopy surface. 
Draw thin lines where the frame would be (like cockpit window divisions). 
Use Extrude with a small thickness (0.5–1 mm) to make raised frame ribs. 
Apply Fillet to soften edges so they look realistic. 
 
Design Hinges: 
Sketch hinge outlines on the fuselage and canopy. 
Use Extrude or Revolve to create cylindrical hinge pins. 
Position them so the canopy can pivot open. 
Use Assemble → Joint to test hinge movement digitally. 
 
Latch Mechanism: 
Create a small rectangular cutout in the fuselage for a latch. 
Model a simple tab on the canopy that fits into this cutout. 
This ensures the canopy stays secure during flight. 
 
Transparency for Printing: 
If you plan to print in clear PETG or resin: 
Keep canopy walls thin (1–1.5 mm). 
Avoid sharp corners — smoother curves print clearer. 
Orient canopy upside down in slicer to minimize support marks. 



 
Split Body for Detachability: 
Use Split Body to separate canopy from fuselage. 
This lets you print them separately and assemble later. 
Add alignment tabs so the canopy snaps into place. 
 
Tips for RC Builders: 
Weight balance: Keep canopy light to avoid shifting CG (center of gravity). 
Material choice: PETG for durability, resin for clarity, PLA for easy prototyping. 
Test fit: Print a small section first to check hinge/latch tolerances. 
 
 
OA-1K Skyraider II Canopy Modeling Workflow in Fusion 360 
The OA-1K Skyraider II has a distinctive canopy with a long, slightly angular profile and raised framing. 
Here's how to replicate it: 
 
1. Import Reference Images 
Use side, top, and front view drawings of the OA-1K. 
Insert them as canvases in Fusion 360 and scale them to match your canopy dimensions. 
 
2. Sketch the Canopy Footprint 
On the top plane, sketch the canopy base outline — typically a rounded rectangle that tapers toward the 
rear. 
Use the Project tool to align it with the fuselage. 
 
3. Create Profile Sketches 
On vertical planes (front, mid, rear), sketch cross-sections of the canopy: 
Front: Slightly curved dome. 
Mid: Flattened arch. 
Rear: Tapered down to fuselage. 
 
4. Use Loft to Shape the Canopy 
Select the profiles and apply the Loft tool to generate a smooth canopy surface. 
Use Rails if needed to control curvature along the sides. 
 
5. Shell the Canopy 
Convert the surface to a solid body using Thicken. 
Apply Shell to hollow it out to ~1.5 mm wall thickness — ideal for lightweight RC printing. 
 
6. Add Framing Ribs 
Sketch framing lines on the canopy surface. 
Use Split Face and Extrude to create raised ribs. 
Apply Fillet for smooth transitions. 
 
7. Integrate with Fuselage 
Use Split Body to separate the canopy from the fuselage. 



Add alignment tabs or hinge pins for detachable mounting. 
Test fit using Assemble → Joint to simulate movement. 
 
Materials & Printing Tips 
Material: PETG clear filament for transparency; LW-PLA for lightweight builds. 
Orientation: Print canopy upside down to reduce support marks. 
Finish: Sand and polish for clarity if using transparent filament. 
 
References: 
How to Model an Aircraft in Fusion 360 | Tutorial 2 - Fuselage | Step-by-Step (4K). 
https://www.youtube.com/watch?v=eBTAxZGYUug  
 
1000mm Air-Tractor AT-802 (+ sky warden) - RC Groups. 
https://www.rcgroups.com/forums/showthread.php?4413841-1000mm-Air-Tractor-AT-802-(-sky-
warden)  
 
Free Fusion 360 Tutorials - 3D Modeling Airplane Course | RC CAD. 
https://www.rccad2vr.com/fusion-360-aviation-design-tutorials  
 
Creating an airplane canopy - Autodesk Community - Fusion. 
https://forums.autodesk.com/t5/fusion-design-validate-document/creating-an-airplane-canopy/td-
p/10916325  
 
Master Your RC Plane Building Skills with Fusion 360 - YouTube. 
https://www.youtube.com/watch?v=ib73dIZiNZ4  
 
 
 
  



Editing STL Files using MeshMixer 
Step 1: Import STL File 
Click on Import, browse your computer, and open the STL file. 
 
Step 2: Edit & Modify STL File 
Click Select and mark different parts of your model. 
Press Del from the menu to delete or remove the unnecessary marked tiles. 
To open different forms for the model, go to the Meshmix 
You can select various options from the sidebar, such as letters. 
Click on Stamp, choose the patterns, and draw them on the model using your mouse. 
To smooth or extrude different parts of the model, go to the Sculpt 
 
Step 3: Export STL File 
Go to File > Export > File Format (.stl). 
 
Check out the video below for a tutorial for modifying STL files. 
https://youtu.be/WMyxVyQ9nFM 
 
 
Step-by-Step Guide to Editing STL Files in Tinkercad 
1. Create an Account and Start a New Project: 
 If you haven't already, create an account on Tinkercad's website. Once logged in, open a new 
project from your dashboard. 
2. Import the STL File: 
 Click on the "Import" button located at the top right corner of the workspace. 
 Select the STL file from your device that you wish to edit. You can adjust the scaling options if 
necessary before clicking "Import" again. The model will appear in your workspace.  
 
3. Familiarize Yourself with the Interface: 
 Ensure you understand the layout of Tinkercad, including the shapes panel on the right, which 
contains various geometric forms you can use to modify your STL file.  
 
4. Editing the STL File: 
 Positioning: Click and drag the imported object to the desired location on the grid. Use the ruler 
tool for precise placement. 
 Resizing: Select the model to see white handles around it. Click and drag these handles to resize 
the object while maintaining proportions. 
 Adding Shapes: To add or cut portions of the model, drag shapes from the shapes panel into the 
workspace. Position them where you want to make alterations. 
 Creating Holes: Use the “Hole” feature to hollow out sections of your model. Select a shape, convert 
it to a hole using the inspector panel, and position it on the STL model. Group the two shapes together to 
execute the cut.  
 Grouping Objects: After making all adjustments, select all components by holding down the Shift 
key and clicking on each object, then click the “Group” button to merge them. 
 
5. Exporting the Modified File: 



 Once satisfied with your modifications, click the “Export” button located at the upper right. Choose 
the “.STL” option from the available formats to save the modified design to your device.  
 
By following these steps, you can effectively modify STL files in Tinkercad, allowing for custom designs 
and adjustments to your 3D models. Happy designing! 
 
 
  



Dark Techno Odonatopter Gunship 
https://www.cgtrader.com/3d-print-models/miniatures/sci-fi/dark-techno-odonatopter-gunship 
 
This multi-part kit contains all you need to build a set of flyer vehicles for the Dark Techno army. 
 
The kit comes with various options : 
multiple cockpit versions, with/without interior detail, and with flat/curved glass. A PDF with cutout for 
clear sheets is also included 
2 hull versions with/without interior 
2 different wing styles (some parts are shown in clear on images, but can of course be printed in solid 
colours 
3 back turret weapons (lasers, machineguns, bombs) 
2 front weapons options (heat, machinegun) 
doors on side of hull with/without gunner crew. 
3 font legs poses (retracted, extended, lowered) 
It fits on standard cross shaped stems, or 8mm acrylic rod. 
 
Models are scaled for 28/30mm gaming. Parts require support. Recommended resin printing, or FDM with 
a 0.2mm nozzle. 
 
 
Scarab Beetle Box (with secret lock) Remix with magnets and customized 
"Catch_drawer" and "catch_lid" 
https://www.thingiverse.com/thing:3718159 
 
I'd like to extend my congratulations to LOUBIE (Louise Driggers) for the outstanding design of the 
scarab beetle box. It truly looks exceptional. However, I encountered a problem with the closing 
mechanism - it didn't work for me. To rectify this issue, I made some adjustments to a few parts. In the 
"Catch_drawer" and in the "middle_part", holes were added for mounting 4 neodymium magnets (4 x 2mm). 
These neodymium magnets are available on Ebay, for example, at 
https://www.ebay.com/itm/303166219032 - 50 pieces for $1.85. Additionally, I made adjustments to the 
closure parts "Catch_drawer" and "catch_lid". It's recommended that these two parts be printed with 
support structures, as the 10° angle of the nose required for proper function may not be printed accurately 
enough without them. With these modifications, the closing mechanism now works perfectly. All parts were 
printed at a layer height of 0.1. The additional components can be found on 
https://www.thingiverse.com/thing:521463 
 
The scarab beetle is a small model with a secret compartment which is accessed by pulling back a "drawer" 
and opening up the beetle's wing case.  The box is locked by closing the wing case and pushing the drawer 
back into place.  Another Thingiverse user (sherpa_chris) came up with the idea of fixing the "head jewel" 
differently, so it can be used as a button to open the wing case (providing the drawer is pulled back) which 
enhances the model in my opinion. You can see his make here: 
http://www.thingiverse.com/make:101797  
 
This model is styled after the "Egyptian Revival" of the 19th and early 20th centuries rather than Ancient 
Egypt.  For more information, visit this excellent page:  



http://www.metmuseum.org/toah/hd/erev/hd_erev.htm 
 
It is worth researching this style as it is beautiful and striking. 
To the ancient Egyptians, the scarab beetle was symbolic of the sun (Ra) moving across the sky every day 
(the beetle rolling a ball of dung was seen to represent this). My model has a stylized beetle with a winged 
Ra between his two front feet. 
The model consists of 12 parts which must be fitted together. All piece’s print without support. 
It also has my design logo on the bottom of it:-) 
 
UPDATE: I have uploaded a third version of the drawer file after it was noted that it had a tendency to 
fall open but the second version was too big.  The file drawer_v3.stl file has a height of 12.45mm whereas 
the fitting for it int he middle_part.stl file is 12.5mm. This may require some sanding  Thanks to MacGyver 
for pointing out the original issue to me and Botmaster for alerting me to the second problem.   
 
Instructions 
The assembly instructions are here: 
http://www.instructables.com/id/The-Scarab-Beetle-Box-Assembly-Instructions/ 
Please read these instructions as they will contain any updates I have had to make and instructions for 
modified files. 
 
 
Double Native American Flute in the key of F# 
https://www.printables.com/@FluteCraft_427746 
 
https://www.printables.com/model/452234-double-flute 
 
Printing recommendations: 
The whole model is designed to be printed without support.  The screenshots show the correct positioning 
on the table. The height of each model does not exceed 180mm. 
 
Speed: 60mm/s 
Print in 3 perimeters! 
Infill: 15% 
Supports: No 
Material: PLA 
 
The model is designed with a 0.1mm offset. On calibrated printers the fit will be perfect. With a larger 
offset, the sound is not good. So, if your printer is not calibrated, you will have to work with sandpaper on 
the joints. I used some silicone grease to make the connection easier. The model consists of 4 parts and a 
sound channel cover. I suggest printing one model at a time. There is also a decorative element of the head 
of an eagle. It consists of 2 halves, which then have to be glued. You can play without it; it is just a 
decoration. 
 
After printing, the holes for the fingers should be calibrated with a drill of the appropriate diameter and 
chamfered.  Each time after drilling, the chamfer should be removed with a chamfer knife. If this is not 
done, the note will sound lower.  



 
For the best results, you can download a guitar tuner and check each note while tuning.  This is an important 
step; you need to tune responsibly for good tuning and sound. The tuning should be done from the bottom 
up. The fundamental note is played with all the holes closed!  You can tune the next note only after the 
previous one is finished. 
 


